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1. Introduction

The information in this file is designed to address most of the problems you may 
encounter when using The Jolly Post Office. If you are having problems with The
Jolly Post Office, please take a look at the items listed in the table of contents to 
see if your particular problem is addressed. If you are still having problems, 
please call our Technical Support number with:

· details of the problem,
· any error messages that were produced, 
· the full specification of your computer.

If possible, you should be beside your machine when you telephone.

The numbers in New York, USA are:

Telephone: 1-800 DKMM 575
Fax: 212 213 5240
E-mail: DKMM@phantom.com

The numbers in London, United Kingdom are:

Telephone: 0171 753 3488
Fax: 0171 753 7575
E-mail: DKMM@DKMM.CO.UK

More help on making the best use of all the features within The Jolly Post Office 
is available once you have started the product, simply by clicking on the 
telephone.

2. CD-ROM problems

2.1 Care of compact discs



Contrary to early reports, compact discs (CDs) are very easily damaged if treated
carelessly. Such damage has a much greater effect on the digital data of a CD-
ROM than on the information of a music CD. A dirty, or damaged CD-ROM is 
quite likely to malfunction. With CD-ROM drives becoming ever faster and more 
disc-sensitive, this is an increasing problem. 

The surface of the disc can quickly gather dirt and is very easily scratched. To 
protect the data from scratches, fingerprints, dust particles, and smears, do not 
touch the readout side (unlabeled side) of the disc or place it face down on a 
hard surface. 

Should the CD become dirty, clean it with a soft cloth lightly moistened with CD 
cleaning fluid, or ethyl alcohol, working from the center to the edge. Do not use 
any type of solvent, such as benzine, lacquer thinner, anti-static agents or LP 
record cleaners as they may damage the surface.

Never leave the disc in a place subject to direct sunlight, high temperature or 
high humidity. Recommended storage conditions are:

· Temperature: 10ºC to 50ºC (50ºF to 122ºF)
· Humidity: 10 percent to 80 percent

2.2 Problems with CD-ROM drives

If The Jolly Post Office has problems finding the data files it needs from its CD-
ROM, you will see an error message saying that the file, animation (ani) or wav 
can't be found. Alternatively, you may simply find that the screen goes blue, with 
white text, and you will get an error message saying that there is an error reading
drive D. To find what has caused the problem, do the following:

1. Check that The Jolly Post Office CD has been correctly inserted into the CD-
ROM drive.

2. Check that The Jolly Post Office is looking in the right place for the CD-ROM 
Drive. If, for example, the drive letter has changed as a result of a system 
change, such as adding or removing a RAM disk, or another device, then The 
Jolly Post Office will fail to find its CD-ROM drive. 

3. If you have an external CD-ROM drive, ensure that it is plugged in, turned on, 
and connected to your computer. You may need to check the documentation that 
came with the drive.

4. Verify that your CD-ROM drive is MPC-compatible and double-speed or faster.

If you have problems with The Jolly Post Office CD vibrating or making a strange 



noise in the drive, then you should contact DK Technical Support using the 
telephone number given at the beginning of this file.

If you get an error message saying that there is a problem reading the disc, then 
you should try cleaning the disc and then restart the product.

3. System requirements

Minimum machine specification:
· A multimedia PC with 486DX/66MHz or faster microprocessor
· 8Mb installed RAM (12Mb recommended)
· Double-speed CD-ROM drive
· Windows 3.1/3.11, Windows 95/NT
· 8Mb available space on hard drive
· SVGA monitor at 640 x 480 pixels, capable of displaying 256 colors
· 8-bit sound
· A mouse

(A modem with a speed of at least 14400 or a LAN (local area network) 
connection. An account with an Internet service provider with full Internet access.
Please note: To make use of the Internet connectivity features, you will need a 
full Internet account that allows you to browse the World Wide Web. AOL users 
will need Windows 95 and AOL for Windows 95 to do this. Compuserve users will
need version 3.01 or above.)

4. Installing and uninstalling The Jolly Post Office

Important: you must disable any screen savers from your machine before
running The Jolly Post Office.

4.1 Installing The Jolly Post Office

Windows 95 users:
1. Insert the disc in the CD-ROM drive.
2 Double-click on the My Computer icon, then double-click on your CD drive icon.
3. Double-click on the setup.exe icon, then follow the instructions that appear on 

your screen.
4. The Setup program creates a program icon in The Jolly Postman program 

group.
5. Double-click on The Jolly Post Office icon to start the program.

Windows 3.1/3.11 users:
1. Insert the disc in the CD-ROM drive. 
2. Go to the File Manager and select your CD-ROM drive. 



3. Double-click on the Setup.exe icon to run the Setup program. 
4. Follow the instructions that appear on your screen.
5. A program group will be created called The Jolly Postman. Open this and 

double-click on The Jolly Post Office icon to start the program.

Please note: If you are reinstalling The Jolly Post Office it is advisable that you 
first run the uninstaller. See "Uninstalling The Jolly Post Office" below.

N.B. If you encounter the system error message "corrupt installation media 
detected", this indicates that your hard drive is full and does not have sufficient 
memory to install The Jolly Post Office or any other application.  You will need to 
ensure you have enough disk space before continuing.

4.2 Uninstalling The Jolly Post Office

Uninstalling The Jolly Post Office frees up space on your hard drive. You may 
also wish to do this to solve errors resulting from altering the original file 
structures. To do this you should first run the uninstaller and then install the 
application afresh.

Windows 95 users:
Go to your Start menu, then Programs, followed by Inner Workings, where you 
will find a shortcut to an application that will uninstall The Jolly Post Office. 

Windows 3.1/3.11 users:
Locate the Inner Workings program group in Program Manager. You will find a 
shortcut to an application that will uninstall The Jolly Post Office.

Please note: The Uninstaller will only remove the original files that were installed
from The Jolly Post Office CD-ROM. Any images which you have saved in 'My 
Pictures' and 'My Stamps' will not be removed.

5. Overview of The Jolly Post Office

5.1 Front Counter

From the post office counter you can reach any of the games, and activities in 
The Jolly Post Office, or click on the objects the customers bring in to take you to
an activity, or game. Audio help is always available by clicking on the receiver of 
the telephone which can be found in any module. The games have three difficulty
levels which can be adjusted by selecting the dial on the telephone. Click the 
bell, or hit the space bar, to return to the front counter at any time.

5.2 Match the Mail



To sort letters for The Jolly Postman while he has a nap, click on the basket at 
the front counter.

Choose a difficulty level on the dial of the phone, and try to find all the pairs. See 
if you can finish before the kettle boils for the Postman's tea. To stop the tea-
making sequence, or the Postman's dream, click anywhere on the screen.

5.3 Broken in the Post

To repair parcels that have been broken in the post, click the pieces on the table.

Choose a difficulty level on the dial of the phone, and then click and drag the 
pieces together. Try to get five in a row for the Postman to collect.

5.4 Parcel Post

To help customers send parcels by choosing stamps, click on the scales on the 
front counter.

Choose stamps to make up the amount shown on the scales; when you think you
have the right amount on the tray, click on the parcel. To remove a stamp from 
the tray, click on it again. See how many customers you can serve before the 
Post Office closes at 5pm. The cash register will show you how much money you
have taken that day when you have finished serving the last customer.

5.5 Where's Jack?

To find Jack from the clues on his postcards click on the globe.

The Giant wants to reply to the postcards that Jack is sending him. Using the 
clues on the postcard, click the state you think Jack is in. The compass and the 
return address will give you extra clues. Try to get eight states right.

5.6 Stationery

To make and print your own stationery click on the clipboard.

Click on a book, and then any of the pictures inside to make them appear on the 
clipboard. The pictures will always appear in the middle of the page, but you can 
click and drag to move them around. To remove a part of the design, pick up the 
scissors from the pot, and click on the part you want to remove. To put the 
scissors back, click on the pot again. When your design is complete, click on the 
print button. You can start again by clicking on the top corner page curl.

You can save your designs in the 'My Stationery' book. Keep the design up on 
the clipboard that you want to save, and open up the 'My Stationery' book. Click 



on the top right hand corner of the book so it says 'Save Me,' then click on an 
empty envelope. To retrieve this design, click the top right hand corner so it says 
'Open Me,' and the design will reappear on the clipboard. Make sure the book 
says 'Open Me' when you want to open up a design. If it says 'Save Me,' the 
design in the envelope will be replaced by whatever is on the clipboard, even if it 
is a blank page, and your design will be lost. Remember to always re-save your 
design once you have taken it out of an envelope.

5.7 Design Room

To make your own stamps click on the design shelf.

To begin drawing choose a pencil, and a color. Click on any of the pictures in the 
book to make them appear on the easel to color them in. If the trail left by the 
pencil is dotty you will need to draw a bit slower. If you make a mistake, click the 
backwards arrow to undo the last thing you did. You can backtrack to undo the 
last three actions. The rubber can be picked up to erase.

Once you are happy with the stamp you have designed you can either send it to 
your personal collection of stamps, 'My stamp Book,' or to the 'World Stamp 
Book' (see below). Click on the frame around the stamp to drag it to one of the 
post-boxes.

Note: If whilst creating a stamp in the Design Room, a dialogue box appears for 
any reason, this may remove the color from your stamp. To recover your image, 
click on the undo button on the easel.

In the Design Room there is a book called 'My Pictures.' This is where you can 
bring pictures from outside The Jolly Post Office into the Design Room. In 
Windows 95 you find this by going to the Start menu, then to Programs, and then
into The Jolly Postman. Here you will find a shortcut to this folder. In Windows 
3.1/3.11 or Windows NT, go to the file manager, and find the folder you installed 
The Jolly Post Office to (eg. C:\TheJPO), and open the 'myData' folder which 
contains the 'myPics' folder. Place any pictures you want to bring into the Design 
Room in this folder. When you go back to the Design Room, the new pictures will
appear in the 'My Pictures' book.

Please note: All images must be in either BMP or PICT format, and in 256 
colors. Make sure that the image file names have either the suffix ".bmp" or
".pct". e.g. dog.bmp. Ideally they should be 152 x 100 pixels, anything
other than this will be resized. However if the aspect ratio is very
different the image may be distorted.

5.8 My Stamp Book

To look at your own stamp collection, click the book with the red stamp on



it at the front counter.

My Stamp Book allows you to view stamps that have been made and kept. You 
can also post a stamp from here to the World Stamp Book or modify it in the 
Design Room. To see more stamps click the corner page curls. To send a stamp 
to the Design Room, or World Stamp Book, click, and drag it, to one of the post-
boxes with the easel, or the globe on it.

6. Internet features

The Jolly Post Office contains access to an Internet connection that allows you to
design stamps, and place them in the World Stamp Book, an online gallery. This 
can be viewed not only by other users of The Jolly Post Office, but also by every 
person that has an Internet account, and standard Web browser (e.g. Internet 
Explorer, Netscape Navigator, etc.). Although other people can view the stamps, 
only users of The Jolly Post Office can design and enter the stamps into the 
World Stamp Book.

To gain access to the World Stamp Book you must have an Internet connection. 
Therefore you must have a direct Ethernet connection to the net or a dial-up 
SLIP or PPP account from an Internet service provider.

If you are able to browse the Internet, then you will be able to use the Internet 
connectivity modules in The Jolly Post Office. You can get a connection to the 
Internet through a service provider in your area.

Check out The Jolly Postman Web site at:

http://www.jollypostman.com

6.1 The World Stamp Book

To visit the World Stamp Book to see stamps that have been sent to the Internet, 
click on the album with the globe on it at the front counter.

Inside the World Stamp Book, the five tabs down the left hand side give more 
information on The Jolly Post Office, and related products, competitions, and 
related information. Click on the name, or letter, in the index on the right hand 
side to access a specific person's stamp, or look through all the stamps by 
clicking on the curled page corners at the bottom left and right of the screen.

When sending a stamp to the World Stamp Book, you will be asked to fill in
details about your name, age, town and country.

You can take copies of stamps from the World Stamp Book, and save them in My



Stamp Book, or take them to the Design Room.

When a stamp is posted to the Internet, it will not appear in the World Stamp 
Book immediately. The stamps will be stored, and entered into the new book at 
regular intervals. On rare occasions stamps can become corrupted when they 
are sent, and therefore, not all stamps will appear in the World Stamp Book.

When using the World Stamp Book, the stamps that you download are stored on 
your hard disk. When a new issue of the World Stamp Book is released, the old 
stamps are removed from your hard disk. If, due to lack of hard disk
space, you want to remove them before a new issue is released, delete all
the files in:

TheJPO\myData\cache\

It is important that you do not delete the cache folder.

Occasionally when you are looking at stamps in the World Stamp Book,
problems with the Internet connections can prevent stamps from appearing.
When this happens, The Jolly Post Office cannot display these stamps and will 
show a default stamp which says 'Lost In The Post' instead. The next time you try
to view that stamp The Jolly Post Office will try to display it correctly again. 
Sometimes these corrupt stamps remain. If this is a recurrent problem you 
should clear the cache folder (see above).

6.2 Connecting to the Internet

If you have configured the dialler to dial on demand, an Internet connection is 
made when you first enter a part of The Jolly Post Office that uses the Internet. If 
you have not configured the dialler to dial on demand, you need to start the 
dialler before you start The Jolly Post Office. If you have already started your 
Internet connection, or have set it to start on demand, The Jolly Post Office will 
use the current Internet settings.

Important: Although The Jolly Post Office will start an Internet connection if 
possible, it is unable to close the connection once it has finished. It is therefore 
important to either set a reasonable time-out in the Internet configuration of 
around 5 minutes, or once you have used the parts of The Jolly Post Office 
connected with the Internet, you exit from the program and close your Internet 
connection.

Please note: If you are running Windows 95, CTRL/ESC brings up the host bar 
which can be used to stop the dialler from inside The Jolly Post Office. With 
Windows 3.1/3.11, if your time-out has not been set, to disconnect from
the Internet you must quit out of The Jolly Post Office entirely, and
disconnect manually.



If you cannot set a time-out, you can cut down the amount of time spent
connected to the Internet by firstly storing all the pictures you wish to send to the 
World Book in My Stamp Book. Then exit The Jolly Post Office, and start up your 
Internet connection. Go back into The Jolly Post Office, and post these stamps to
the World Stamp Book from My Stamp Book. When this has been done, exit The 
Jolly Post Office again, and disconnect from the modem.

6.3 Understanding the error messages

If a problem occurs while using the Internet connection with The Jolly Post
Office, a dialogue box offers parental help containing the error message, and 
error code which can be matched to the error categories below.

Clicking on the 'Parental Help' button will bring up an error number, and error 
message. For example you may see the following :

" Problem initialising modem or network (-18)"

There are a total of six error messages, each described in its own section
below. You should therefore match your error against one of these messages,
and read the corresponding section. In most cases the problem will most
likely be caused by your Internet connection, in which case you should
contact your Internet service provider for assistance. However, if the
problem cannot be solved through this route, contact the help line using the 
number at the top of this file.

"Problem initialising modem or network"
This means that The Jolly Post Office could not find a way to connect to the 
Internet. This may be caused by a number of problems so begin by checking the 
following:

1. Check that your modem is switched on (if applicable) and that all network 
cables are connected properly.

2. Check that you have access to the Internet by using another Internet product. 
For example, you may try launching a Web browser, and testing whether you 
can access the Internet.

3. If you cannot access the Internet in any way, either your Internet Service 
Provider (ISP) is not available or, your machine's network settings are 
incorrect. In both instances you should contact your ISP for advice on how to 
rectify the problem.

4. If you can access the Internet, then this means that The Jolly Post Office is 
having problems finding your Internet connection. This is most likely to be the 
case when using older machines and modems. The software in The Jolly Post
Office sometimes cannot start this Internet connection itself, so we advise that 
if you are going to use the Internet parts of The Jolly Post Office that you 



connect your modem to the Internet before starting.

It should be noted that some ISP’s do not provide full Internet access as
standard. If you have problems running standard Internet software, such as a
Web browser that has not been provided by your ISP, then you may not have a 
full Internet connection. If this is the case, then you should contact your ISP, and 
ask them how to use standard Internet software with your connection.

"Could not contact host server"
This means that The Jolly Post Office cannot contact the Internet servers that are
dealing with the Internet parts of the product. Most problems of this nature are 
temporary, and so can be resolved by trying again at a later stage. This can 
happen for a number of reasons:

·  Internet servers are quite often unavailable because the computers hosting 
these servers are down. You can check this by trying to visit the host machine 
using a web browser. Try connecting to:

 http://www.jollypostman.com/

If you cannot contact the server, but can contact other sites on the Internet, 
you should wait until the server becomes available again. If you cannot contact
any other sites, then there is a problem with your network connection. Please 
run through the section above "Problem initialising modem or network".

· Sometimes Internet servers become inundated with requests for information. 
This means that you can be refused your connection to the server if the host is
busy. Try again at a later stage.

· On a really slow connection you won't even be able to receive a refuse 
message. The connection will time-out after a minute, or so, of trying. Try 
lengthening your time-out period on your modem.

· Another problem may be that your server address file has been damaged. If 
this information has changed, then it is likely that The Jolly Post Office is trying
to contact the wrong server at a different address. You should replace the file 
'ip.ini' in your Jolly Post Office folder with the original from the CD which can 
be found in the corresponding folder:

InstData\indata

There are actually two servers that deal with the Internet aspects of The Jolly 
Post Office. One manages any files that are posted to the Internet, and the 
other maintains the World Book. If you can view the World Book, but cannot 
post files to the Web, and vice-versa, then it may be that one of the servers is 
not responding. One server is accessed using File Transfer Protocol (FTP), 
and the other Hypertext Transfer Protocol (HTTP). Your ISP may not provide 
you with both these protocols. You should check with your ISP that they 



provide both these services.

"The network connection has been broken"
This means that The Jolly Post Office was able to initialize your network 
connection, contact the required host server, and was in the process of 
transferring files when something went wrong. This can happen for a number of 
reasons relating to the server, or the connection timing out. In all cases you 
should try connecting again at a later stage.

"Out of memory"
This means that The Jolly Post Office has run out of free memory to work with.

1. First check that your machine has at least 8Mb RAM installed as noted in the 
minimum machine specification.

2. Quit all other applications that are running. This should free up more memory.
3. Sometimes runaway processes, or crashed applications, do not release 

system memory. Try restarting your machine.
4. Check that your memory configuration is optimised for your machine. Consult 

your PC user manual.

"Local file handling problem"
1. One frequent cause of this problem occurs when you try running The Jolly 

Post Office from the CD-ROM instead of by copying it to your hard disk. If you 
have not already installed The Jolly Post Office on your hard disk, see 
"Installing The Jolly Post Office" section at the start of this document.

2. The Jolly Post Office will try to create new files as they are required. Ensure 
that you have adequate free hard disk space available.

3. The Jolly Post Office expects a particular file structure to be in place. If folders 
have been renamed, or removed from their expected position, then The Jolly 
Post Office will not be able to complete functions. In this case reinstalling the 
application will solve the problem. See "Installing The Jolly Post Office".

4. If you have locked, or altered, the sharing settings on any of The Jolly Post 
Office files, or folders, installed onto your hard disk, you may encounter this 
problem. The most direct way to solve this is to reinstall The Jolly Post Office.

"Internal problem"
An error has occurred within The Jolly Post Office application which is not 
relating to your Internet connection. Therefore, make a note of the error number, 
and the circumstances in which the error occurred, and call our helpline using the
number at the top of this file, quoting the error number.

7. Screen display notes

7.1 Screen resolution and color settings



The Jolly Post Office has designed to look its best with a screen resolution of 640
x 480 pixels. All screen images are created in this size, and will completely fill the
screen at this resolution. This means that running your screen at a higher 
resolution (such as 1024 x 768 pixels) will result in a smaller image of The Jolly 
Post Office being displayed. (It is NOT possible to maximize the product to fill 
screens with a resolution higher than 640 x 480 pixels.) 

The Jolly Post Office is designed to run in 256 colors. The Jolly Post Office will 
not run in color depths other than 256 colors, but will display an error message. 
Instructions are given below explaining how to change to 256 colors for Windows
95 users, and also for Windows 3.1/3.11 users with Cirrus Logic and Diamond 
Stealth display adapter cards. All other users should refer to their display adapter
documentation for instructions how to do this.

Note: Please write down your display adapter card's settings before you make 
any changes. That way, you will be able to revert to your original settings should 
you need to.

Windows 95 users:
1.From the 'Start' menu, choose 'Settings,' and then 'Control Panel.'
2.Double-click on the 'Display' icon. A 'Display Properties' dialogue box will 

appear.
3.Click on the 'Settings' tab.
4.Under 'Color Palette,' choose '256 colors.' 

Windows 3.1/3.11 users with Cirrus Logic cards:
1. In Windows 'Program Manager,' double-click on the 'VGA Utilities' icon.
2. A 'VGA Utilities' program group should appear. It will contain either a 'SetRes' 

icon, or a 'WinMode Utility' icon, depending on the type of Cirrus Logic card 
you have. Double-click on this icon. (If you do not have a 'VGA Utilities' icon, 
then you should look for either a 'SetRes,' or 'WinMode' icon.)

3. Select '640 x 480' from the list of available screen resolutions.
4. Select '256' from the list of colors available. 

Windows 3.1/3.11 users with Diamond Stealth cards:
1. In Windows 'Program Manager,' double-click 'Windows Control Panel' in the 

'Main' program group.
2. Double-click the 'InControl Tools' Diamond icon.
3. Select the 'Display' button to see options for color depth, and select 256 color 

mode. 

If, for any reason, you select an incorrect, or unsupported driver:

Windows 3.1/3.11 users:
1. Go to the system prompt, and change directory to your Windows directory by 

typing 'C:,' then press 'ENTER.' 



2. Now type 'CD C:\WINDOWS.' Press 'ENTER' again, then type 'SETUP.' 
3. You can now reinstall your original driver.
4. If you did not make a note of your display adapter, and are not sure what it 

was, select the VGA driver (not VGA version 3.0.)
5. Contact your machine supplier (or display adapter supplier) to obtain updated 

drivers.

Windows 95 users:
1. Start Windows in 'Safe mode.' Do this by holding down the 'F8' key when the 

'Starting Windows 95' message appears on the screen. 
2. Choose 'Safe mode' from the menu. 
3. You can now reinstall your original driver.

7.2 Images appear in monochrome

Some color display adapters may display The Jolly Post Office images in black 
and white. If this happens, you should upgrade your display driver. Contact the 
supplier, or manufacturer of your display adapter, to check that you have the 
latest display drivers.

7.3 Images are truncated

Some display drivers are designed to use large fonts. If your system is using one 
of these, any image in the main window will appear slightly truncated. Windows 
3.1x users can run the 'Windows Setup' program to change the default display 
driver to one that does not default to large fonts. Windows 95 users can do this 
by selecting 'Settings' from the 'Start' menu, then by double-clicking on the 
'Display' icon. Click on the 'Settings' tab, then select a different font size from the 
'Font Size' drop-down list.

8. Problems with animations and video

8.1 General problems 

If you are a Windows 3.1x user, and animations, or videos play jerkily, your 
system may have too little memory available to run them smoothly – on 
machines with only 8Mb of memory, restrict the SMARTDRV setting that controls 
the size of the disk cache for use inside Windows to 512K, or less. If you are 
running Windows 3.1x make sure that the SMARTDRV settings in your 
AUTOEXEC.BAT file enable SMARTDRV to cache your CD-ROM drive 
efficiently. Consult your Windows documentation for further information on how to
check and adjust these settings. You should also try consulting Section 10, 
Running Out Of Memory Or Running Slowly, for further advice. You should also 
check that the CD-ROM is free from dust, and dirt. See section 2.1, Care of 
compact discs, for more information.



QuickTime™ for Windows 2.1.2 
This product uses QuickTime™ for Windows 2.1.2. If you cannot play videos in 
The Jolly Post Office, then you should check the following:

·  Did you restart your computer after installing The Jolly Post Office? If you did
not, do this before trying to run The Jolly Post Office again.

·  Did you choose to delete old versions of QuickTime™ for Windows when 
prompted by QuickTime™ Setup? If you did not, then you should run The 
Jolly Post Office Setup program again, and when the QuickTime™ Setup 
starts you should choose to delete all old versions of QuickTime™ when 
prompted. 

·   If you chose not to install QuickTime™ for Windows from The Jolly Post 
Office CD, check that you have QuickTime™ for Windows version 2.1.2 or 
later already installed on your PC. If you do not, you should reinstall The Jolly
Post Office, and this time choose to install QuickTime™ for Windows from 
The Jolly Post Office CD. Restart your computer before trying to run The Jolly
Post Office again.

·  Someone may have removed QuickTime™ for Windows from your computer.
Run The Jolly Post Office Setup program to reinstall QuickTime™ for 
Windows. Restart your computer before trying to run The Jolly Post Office 
again.

If video playback is poor quality, or if videos crash (usually caused by older 
video drivers), then check the following…

1. Open the Windows ‘Control Panel’
· Windows 3.1/3.11 users: Choose the ‘Main’ program group in 

‘Program Manager,' then double-click on ‘Control Panels.' 
· Windows 95 users: From the ‘Start’ menu on the ‘Task Bar,' select 

‘Settings,' then ‘Control Panels.' If you see two QuickTime™ control 
panels, perform steps 2. to 4. on both of them.

2. Double-click on the ‘QuickTime™’ icon to open the ‘QuickTime™ Control 
Panel.'

3. Click the ‘More’ button, then click on the ‘Video’ tab.
4. Click ‘Video Driver’ in the ‘Draw Method’ box, then click ‘Apply.'
5. Restart The Jolly Post Office.
6. If you still have video playback problems, or if the application still does not 

work, repeat steps 1-4 and choose a slower draw method (listed in the ‘Draw 
Method’ box from fastest to slowest). You should also ensure that you have 
installed the latest video driver from your computer manufacturer, or display 
adapter manufacturer.

If you have problems with videos and sound not synchronizing properly, or if the 
pitch of sound in videos seems wrong, try the following:



1. Open the Windows ‘Control Panel’
· Windows 3.1/3.11 users: Choose the ‘Main’ program group in 

‘Program Manager,' then double-click on ‘Control Panels.' 
· Windows 95 users: From the ‘Start’ menu on the ‘Task Bar,' select 

‘Settings,' then ‘Control Panels.' If you see two QuickTime™ control 
panels, perform steps 2. to 4. on both of them.

2. Double-click on the ‘QuickTime™’ icon to open the ‘QuickTime™ Control 
Panel.'

3. Click the ‘More’ button, then click on the ‘Audio’ tab.
4. Check that the ‘Audio Rate Adjustment’ box is NOT checked.
5. Click the ‘Apply’ button.

8.2 Solving problems with animation and video for Windows 95 users

If you are running The Jolly Post Office under Windows 95, and have problems 
with animations, or videos (for example, jumpy animations, or distorted colors), 
there are two main steps you can try to solve your problems. Try the steps in the 
order given, and stop when your problem is solved:

8.2.1 Checking your display adapter's acceleration settings,
8.2.2 Changing your display adapter driver.

8.2.1 Checking your display adapter's acceleration settings
1. Click on the 'My Computer' icon using the right-hand mouse button, then 

select 'Properties.'
2. In the 'System Properties' box you should click on the 'Performance' tab.
3. In the 'Advanced Settings' box, click the 'Graphics' button.
4. In the 'Advanced Graphics Settings' box you should move the 'Hardware 

Acceleration' slide-control down to 'None,' then click 'OK.'
5. If this solves your problem you should try slowly increasing the 'Hardware 

Acceleration' slide-control until you find the point nearest to 'Full' at which your 
problem still remains solved.

6. If this does not solve your problem you should put the slider back to 'Full,' and 
try the next step.

8.2.2 Changing your display adapter driver
1. From the 'Start' menu, select 'Settings,' then 'Control Panel.'
2. Double-click on the 'Display' icon, then click on the 'Settings' tab.
3. Click on the 'Change Display Type' button, then on the 'Change...' button 

under 'Adapter Type.'
4. Click on 'Show Compatible Devices.'
5. From the list shown, ensure that the driver highlighted is the one to match your

display adapter. You can check this with your computer manufacturer, or 
supplier. 

6. If the driver is not the correct one, then you should ask your computer 
manufacturer/supplier to send you one.



In the mean time, or if you already had the correct driver installed, you can try 
installing the generic SVGA driver. 

1. From the 'Start' menu, select 'Settings,' then 'Control Panel.'
2. Double-click on the 'Display' icon, then click on the 'Settings' tab.
3. Click on the 'Change Display Type' button, then on the 'Change...' button 

under 'Adapter Type.'
4. Click on 'Show All Devices.'
5. From the list of manufacturers, choose 'Standard display types.'
6. In the 'Models' list-box, select 'Super VGA,' then click 'OK.'

If the SVGA driver solves your problem, this shows that it was the original display
adapter driver that you had installed that was causing the problem. You will need 
to obtain the most up-to-date version of the drivers for your display adapter, and 
check to see if they solve your problem – contact your computer manufacturer, or
supplier, for these.

8.3 Solving problems with animation for Windows 3.1/3.11 users

If you are running The Jolly Post Office under Windows 3.1 or 3.11, and have 
display problems (for example, jumpy animations, or distorted colors) try should 
changing your display adapter driver. However, if you have either a Diamond 
Stealth 64, Cirrus Logic 542X, or Cirrus Logic 543X display adapter card, then 
you should go to the sub-section for that particular card and follow the 
instructions that appear there first. If these do not solve your problem, you should
return to this section, and follow the instructions given here. If you do not know 
what type of display adapter card you have you can find out by doing the 
following:

1. In Windows 'Program Manager,' double-click on the 'Main' program group icon.
2. Double-click on the 'Windows Setup' icon.
3. The text next to 'Display' in the window tells you the type of display adapter 

you have. You should note this down before changing anything.

Changing your display adapter driver:
First check that the correct display adapter driver is installed (as described 
above). The name of the driver should match the name of your display adapter 
card. If the driver is not the correct one, then you should ask your computer 
manufacturer, or supplier, to send you the correct driver. 

In the mean time, you can try installing the generic SVGA driver

8.3.1 Installing the Microsoft Super VGA Driver. 
These instructions assume that you have version 3.1 or 3.11 of Windows, and a 
Super VGA compatible display adapter. If you are not sure, please refer to your 



display adapter documentation, or ask your computer supplier, or manufacturer. 

Note: Before installing the SVGA driver, please make sure that you have a back-
up copy of your original display drivers, in case you need to reinstall them later.

1. In Windows 'Program Manager,' double-click on 'Windows Setup' in the 'Main' 
program group.

2. Select 'Change System Settings...' from the 'Options' menu.
3. Select 'Other display (Requires disk from OEM)...' at the bottom of the 

'Display' drop-down list.
4. Type over the 'A:\' and replace it with 'D:\SUPPORT\MSSVGA' (where D is the

letter of your CD-ROM drive).
5. Select 'Super VGA 640x480 256 colors' and click 'OK.'
6. Exit Windows, and then restart your computer before trying to run The Jolly 

Post Office again.

For more information, check your Windows documentation, your display adapter 
manual, or contact your supplier.

If the SVGA driver solves your problem, this shows that it was the original display
adapter driver that was causing the problem. The solution to your problem would 
be to obtain the most up-to-date version of your display adapter drivers to see if 
they solve your problem – contact your computer manufacturer or supplier for 
these.

8.3.2 Diamond Stealth 64 display adapter cards
Windows 3.1/3.11 users who have Diamond Stealth 64 display adapter cards and
experience any of the following problems...

· Animation 'shearing' type effect
· Animation displaying offset from the correct position on the screen
· Monitor powers down, and will not resume

...should follow the instructions below. Try the steps in the order given and stop 
when your problem is solved:

The ideal solution to these problems would be to obtain the latest drivers from 
your computer manufacturer/supplier. For users of Diamond Stealth 64 DRAM 
cards we have included the latest drivers on The Jolly Post Office CD, and you 
should try installing these:

1.  In Windows 'Program Manager,' double-click on 'Windows Setup' in the 'Main' 
program group.

2.  Select 'Change System Settings....' from the 'Options' menu.
3.  Select 'VGA' in the 'Display' section, then click 'OK.'
4.  A message will appear on the screen:



"A driver for this display is already on the system. Do you want to use the 
currently installed driver or install a new driver?". 

You should click 'Current.'
5. Make sure you exit and restart Windows.
6. In Windows 'Program Manager,' select 'Run' from the 'File' menu.
7. Type in D:SUPPORT\DIAMOND\INSTALL (where D is the letter of your CD-

ROM drive). Follow the instructions that appear on your screen.

Diamond have built in a preference for older programs in their drivers. To bypass 
this, in order for animations to work properly in many of our programs, you should
change the following line in the 'SYSTEM.INI' file: 

Please note: Editing the system.ini can cause system problems if not done 
properly. We suggest that you take a backup copy of your system.ini before 
making any changes, and only proceed with making changes if you are sure of 
what to do.

To edit the 'SYSTEM.INI' file:

1. Select 'File' in 'Program Manager,' then 'Run.'
2. Type SYSEDIT in the text box, then press return. Sysedit should load.
3. Select 'SYSTEM.INI' as the file to edit from the 'Window' drop-down menu.
4. Select 'Find' from the 'Search' menu, then type:

[STLTH64.DRV]

then press Enter. If the [STLTH64.DRV]line is highlighted in the system.ini file, 
then change the line:

DEVICEBITMAPS=0

to

DEVICEBITMAPS=1

If you get the message "cannot find [STLTH64.DRV]", you should edit the 
system.ini file by adding the following lines:

(Hold down CTRL + End, this will take you to the end of the file)
(press enter)
[STLTH64.DRV] (now press enter)
DEVICEBITMAPS=1 (now press enter)
(press enter again)



When you have finished editing the file, select 'File' then 'Save' to save your 
changes.

8.3.3 Cirrus Logic 542X display adapter cards
Windows 3.1/3.11 users who have Cirrus Logic 542X display adapter cards, and 
who experience problems with animations, should follow the instructions below to
install the most up-to-date driver. This is provided on The Jolly Post Office CD-
ROM. To install the driver:

1. In Windows 'Program Manager,' double-click 'Windows Setup' in the 'Main' 
program group.

2. Select 'Change System Settings....' from the 'Options' menu.
3. Select 'VGA' in the 'Display' section, then click 'OK.'
4. A message will appear on the screen:

"A driver for this display is already on the system. Do you want to use the 
currently installed driver or install a new driver?". 

You should click 'Current.'
5. Make sure you exit and restart Windows.
6. In the Windows 'Program Manager,' select 'Run' from the 'File'
menu.
7. Type in D:\SUPPORT\CIRRUS\INSTALL (where D is the letter of your CD-
ROM drive).

8.3.3 Cirrus Logic 543X display adapter cards
Windows 3.1/3.11 users who have Cirrus Logic 543X display adapters, and who 
experience the following problems:

· Animations play with a distorted color palette
· Animations display blurred images, or looks like a photographic negative.

Should try to obtain the latest drivers from your computer manufacturer/supplier. 

9. Sound problems

9.1 No sound output, but the product otherwise runs fine

There are many possible causes of audio problems. For example, your computer
can only play one sound at a time, so when another application is playing a 
sound, The Jolly Post Office cannot do so; you will get an error message in these
circumstances. Most applications only prevent other programs from playing a 
sound when they themselves are doing so, however, some applications, such as 
certain Screen Savers, remove audio capability from all other Windows 
applications. If you have such an application, you should turn it off when you are 



running The Jolly Post Office. 

You should check that the speaker is hooked up to the jack on your sound card, 
and not hooked directly to the CD-ROM drive headphone socket. 

If you cannot hear sound in The Jolly Post Office, you can test sound in the 
following way:

Windows 95 users:
1. From the 'Start' menu, select 'Settings,' then 'Control Panel.'
2. Double-click on the 'Sounds' icon.
3. Click on any item with a speaker next to it, then click the 'Preview' button.

Windows 3.1/3.11 users:
1. In 'Program Manager,' choose 'File,' then 'Run.'
2. Type 'chimes.wav' in the text-box, then click 'OK.'

If you can hear sound, there is some other problem with The Jolly Post Office. If 
you can't hear sound, you may not have the correct sound drivers installed. 
Check with your sound card manufacturer to see if you have the correct drivers, 
and that there are no hardware conflicts. If your sound card came with your 
computer, call your computer supplier.

9.2 Audio is fuzzy or distorted

There are a number of possible causes of fuzzy, or distorted sounds. Problems 
are often caused by low quality speakers, speakers set to high or maximum 
volume, or speakers powered by batteries that are failing. You should also be 
aware that some speakers are not capable of playing low frequency sounds 
properly. If sound is interrupted, this may be caused by low memory – refer to 
section 7.

Some sound cards have software that allows you to adjust the volume, AND 
tone, of the sound. If this is the case with your sound card, start with these tone 
controls set in the mid position and your volume level set at 50 percent. This 
should give a clear signal with no distortion. Check your sound card manual for 
the optimum settings.

Powered speakers are best and, if possible, should be placed either side of the 
screen. You may need to adjust the position of these speakers slightly if the 
magnets in the speakers are unshielded, and cause discoloration, and distortion 
of the image.

If your CD-ROM drive is not MPC-compatible, then the sound may play badly, or 
be interrupted when playing. Check your CD-ROM drive's documentation to 
ensure that it is a double-speed, or faster, CD-ROM drive. If you do have a 



double speed CD-ROM drive, and if you are also a Windows 3.1x user, or a 
Windows 95 user with no 'CDROM' icon in Device Manager (you can check this 
by selecting 'Control Panels' from the 'Start' menu, and by double-clicking on the 
'System' icon. Select the 'Device Manager' tab, and check to see if a 'CDROM' 
icon appears in the list), then you should follow the advice in about 'smrtdrv' in 
sections 7.1 and 7.2 of this Read Me.

9.3 Sound plays too quietly

Make sure the volume is set to an audible level. Check the sound card itself, the 
speakers, or headphones if they have a volume control, and any software that 
may have been supplied with your sound card that can change the volume level. 
If there is a mute button in the audio software, or on the speaker, check that this 
is not activated.

If the sound controls are set to an audible level, then you could try new speakers 
or headphones to see if they solve the problem.

10. Running out of memory or running slowly

The Jolly Post Office uses your computer's system memory to display pictures. If 
you find that The Jolly Post Office runs slowly, or if you come across out-of-
memory errors, the program probably does not have enough memory. Consider 
doing the following to improve your computer's performance:

1. Windows 3.1x users who have machines with only 8Mb of memory, and 
Windows 95 users with no 'CDROM' icon in Device Manager (you can check this 
by selecting 'Control Panels' from the 'Start' menu, and by double-clicking on the 
'System' icon. Select the 'Device Manager' tab, and check to see if a 'CDROM' 
icon appears in the list), should restrict the SMARTDRV setting that controls the 
size of the disk cache for use inside Windows to 512K or less. If you are running 
Windows 3.1x, make sure that the SMARTDRV settings in your AUTOEXEC.BAT
file enable SMARTDRV to cache your CD-ROM drive efficiently. Consult your 
Windows documentation for further information on how to check and adjust these
settings. DOS 5.0 does not cache the CD at all – users with DOS 5.0 should try 
upgrading either DOS or SMARTDRV for a later version. You can check whether 
your CD-ROM drive is cached by going to the DOS prompt, and typing 
'SMARTDRV.' This will show you a list of drives that are cached.

2. Windows 3.1x users should check that 'MSCDEX' which appears in the 
'AUTOEXEC.BAT' file is version 2.23 or later, and appears before the 
'SMARTDRV' entry. You can do this by typing 'MSCDEX' at the system prompt in 
MS-DOS. If in no version number is given, then you can be sure that your version
of 'MSCDEX' is older than version 2.23. Versions of 'MSCDEX' older than 2.23 
should be upgraded – contact Microsoft for these.



3. Close any unnecessary applications, including any DOS Terminate and Stay 
Resident programs (TSRs) you may have installed.

4. Check that your computer has at least 8Mb of memory. Windows 3.1/3.11 
users can do this by leaving Windows, and typing 'MEM' at the system prompt. 
Look for total memory in the Total column. Windows 95 users can do this by 
right-clicking on the My Computer icon and selecting Properties – the amount of 
installed RAM appears under Computer. If the figure reads 8192Kb (8Mb) or 
more, then you have at least 8Mb of memory. If you have less than 8Mb 
(minimum 8192Kb) of memory, then you need to install some more.

5. Windows 3.1/3.11 users should check that Windows has sufficient memory 
available for The Jolly Post Office. Do this by selecting 'About Program Manager' 
from the 'Help' menu in 'Program Manager.' The memory available should be a 
least double the amount of your installed RAM. The extra memory here indicates 
the presence of a Windows swap file. You may find more memory becomes 
available if you restart Windows. If you still have less than double the amount of 
your installed RAM this indicates that either you have no Windows swap file, or 
that the swap file is too small. If this is the case, you should follow step 6 below. 
Windows 95 users should ensure that there is plenty of available hard disk space
to allow the swap file to grow if necessary; at least 20MB is recommended.

6. Windows 3.1x users who are running Windows in Enhanced mode, set up a 
permanent Windows swap file on your hard disk of a least double the amount of 
your installed RAM. You can do this by following the instructions in your Windows
documentation.

7. If you are running DOS 6.0 or higher, then you can run the MEMMAKER utility 
to optimize the memory in your computer. (For example, if you answer 'No' to the 
question 'Do you use any programs that need Expanded Memory? ,' 
MEMMAKER will free further conventional memory by inserting the switch 
NOEMS in the appropriate line in your PC's CONFIG.SYS file.) Consult your 
Windows documentation for further information on using MEMMAKER.

8. Speed up your hard disk by defragmenting it. There are a number of tools 
available to carry out this task, including the 'DEFRAG' command found in MS-
DOS version 6.0 and later.

11. Printing

Printing screens from The Jolly Post Office may take several minutes, depending
on the type of printer you use. Since screen resolution and printer resolution are 
often different, the printout may not match the quality you see on the screen. 



If you are not happy with the position on the page, or the size of your print out, try
using the copy function to copy and paste the picture into another application 
such as a word processor, or paint package, before printing.

You can change the settings of your printer from within The Jolly Post Office by 
clicking on 'Print' on the navigation bar, then waiting for the print dialogue box to 
appear. Click on 'Print Setup' to display the 'Print Setup' dialogue box. (Please 
note: an explanation of the Print Setup dialogue box is available in your Windows
documentation.) 

Some dot-matrix printers may not print pictures properly with the 'Low / Faster' 
quality setting in the 'Print Setup' dialogue box. On these printers change the 
quality setting in the 'Printer Settings...' dialogue box to 'High / Slower.' Users of 
dot-matrix printers may also find that their print-outs have strange proportions. If 
this is the case, you should ensure that the dpi option is the same for both 
horizontal and vertical settings.

Because the pictures can be quite large, you may have difficulty copying or 
printing in low-memory conditions. In this case, follow the advice in section 7 of 
this file, and try again.

If any of the following printing problems occur:

· Nothing happens after the 'Printing' message
· Corrupt output
· Blank paper output

When any of these occur the following steps should be taken, in the order given. 
Stop when your problem is solved.

1. Try printing bitmap pictures from a different application to see if all printing is 
affected. Also make sure that you have the latest driver – you should contact 
your printer manufacturer or vendor to check this.

2. Try different modes of printing, for example, different print quality such as draft,
fine, line art. The options available will vary depending on the type of printer 
(check your printer Setup documentation for information on how to do this).

Windows 3.1 users:
1. Ensure that TEMP is set in the 'AUTOEXEC.BAT' file to a valid directory, for 

example, a line in the 'AUTOEXEC.BAT' could say SET TEMP=C:\WINDOWS\
TEMP. This directory must exist and there must be room on your hard disk for 
this 'temp' file to be created.

2. Check your hard disk with the 'Scandisk' program, provided with DOS, and 
choose to repair all errors it flags. Then re-install the printer driver.

3. Obtain the most up-to-date printer driver available. Contact your printer 



supplier/manufacturer to do this.
4. Try another compatible printer driver.

Windows 95 users:
Use the Printer Wizard to reinstall your printer. Do this by going to the 'Start' 
menu and selecting 'Settings,' then 'Printers.' Follow the instructions that appear 
on your screen.
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